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Chapter 1
Hardware and software requirements

1. Hardware and software requirements

Hardware requirements
In order to follow this guide you need:

• 1 eWON with viewON capabilities (for example: eWON Flexy)
• 1 PC with an Internet access and an up-to-date web browser

Software requirements
eWON configuration software:

The eWON is configured through its embedded web server. So all you need is a 
standard web browser software like Internet Exploreri, Firefoxii or Chromeiii.

Additionally we suggest to download the eBuddy utility on our support website: 
http://support.ewon.biz/software

The eBuddy utility lists all the eWONs available on your network and changes the 
default IP address of an eWON to match your LAN IP address range.
With eBuddy you can also easily backup/restore your configuration or upgrade the 
firmware of your eWON (if required).

viewON  software:

To create a viewON project, the viewON Editor is needed on your PC.

To visualize the exported viewON application on the eWON you simply need an up- 
to-date web browser (IE10 and higher, Mozilla FireFox, Google Chrome,...). This 
makes the viewON project visualization compatible with any kind of platform 
(computer, tablet, smartphone) and any kind of OS (Windows, Linux, MacOS, iOS, 
Android).

The setup of viewON can be downloaded on the eWON web site: 
http://support.ewon.biz/software

- Note -

viewON might not be 100% compatible with IE 10. Such animations (i.e: Text on Interval) don't 
work properly when using Microsoft browser IE 10. 
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eWON firmware version
To be able to follow this guide, your eWON needs a firmware version 7.1s0 or higher.
A simple way to upgrade the eWON firmware is to use eBuddy, the eWON software 
companion.

As of version 8.0, Cloud Accelerated Loading is supported. This feature makes the 
loading of an eWON web page faster, including viewON and configuration web 
pages. This is useful especially when using slow communication media.
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2. viewON Installation

Setup Wizard
Launch the setup.exe file and follow the different steps to install the viewON 
application on your PC.

Choose the language for the installation wizard. 
This language will also be used for the viewON Editor interface.

Select or type the path where viewON will be installed. We advise to keep the 
default path.
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Click Finish to exit the Setup wizard.

viewON Registration
Before registering your viewON software, you will need to buy a license. This one 
must be bought to your local distributor.

To register your viewON software open the «Registration Information» window using 
the «Registration» option in the “Help” tab from the top bar menu of viewON.

To get an Activation Key, click on the «Registration site...» link.

You will be redirected to the viewON registration form. Fill it and click «Submit» to 
confirm your entries.
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- Note -

In this form, the serial number must be asked to your distributor. It has nothing to do with the 
serial number of your eWON.

After validation, you will receive an email containing your Activation Key.

You can now register the viewON software by filling the "Company name" and 
"Activation Key" fields of the «Registration Information» window and click "Register".

Need more info? Check the KB-0153: Register your viewON

viewON Updates
If the PC running viewON has an Internet connection, there is an automatic check 
for available updates when viewON starts. If updates are available, it displays a 
message at the top right of the main toolbar in the working area:

By clicking on the link, you will be redirect to eWON website in order to download 
the new version of viewON.
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3. Create your first viewON project
This chapter describes the different steps to follow in order to create your first 
viewON project.

Create a new project

Define the project name and the IP address of your eWON.

In the «User» and «Password» fields, enter the eWON account that has administrator 
rights or any other eWON account which has enough FTP access rights. Compiled 
files are uploaded to eWON through the FTP protocol. 

In the «Refresh rate» field, enter the refresh rate in seconds at which the viewON 
web page should read the Tags value from the eWON. 
If you attempt to visualize the viewON application over a low connection (GPRS, ...) 
then it isn't recommended to specify a too low refresh rate.

In the «Refresh timeout» field, enter the time interval in seconds viewON should wait 
for an answer when asking to refresh the tags value. 

Import Tags from your eWON
To import the eWON Tags, use the Import tags feature in the Project Menu.
You will then be able to associate the eWON Tags to animations, actions or even 
your own custom code.
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If the HTTP transfer has been done successfully, the above message should appear. 
The Tags should then be imported from the eWON to the viewON project. 

Add views to the project
In the project editor, right click on the project name to show up the context menu 
and click “Insert new view”.
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- Note -

A view can be compared to a web page where parameters were configured to display 
objects, animations, ... based on who's browsing the view, the actions he's performing, the 
device he uses to browser...
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You will need to define some of the view specifications:

• View name: Put the name you wish to set for the view

• Screen: Set up the device the view has been designed for. Following the 
selected item, the width and height will automatically adapt.

• Orientation: If the view should be in a horizontal or vertical mode by default.

• Width / Height: The size of the view can be customized (the Screen field will 
adapt automatically).

• Fit to screen: By checking this box, you avoid the need for users to scroll when 
displaying the project on small resolution devices.

• Keep aspect ratio: Should the project always respect the width/height ratio or 
can it be distorted?

Because views can be adapted regarding the platform used (smartphone, tablets, 
…), check the Mobile view chapter.

Define the Main view
After adding 3 views (named View1, View2, View3) the project explorer should look 
like this:

To define the view that will be displayed first at the start-up of the viewON 
application, right click on the view in order to open the context menu and select 
«Main view».

In the Project editor, the Main view is displayed with a red square around its icon.
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Add animations and actions to your objects
Inside the views, add objects and link animations and/or actions to the objects.

Click “Drawing → Rectangle, Ellipse, Path, Image, Text, Symbols, Graphical 
components,... and then position it in the view 

The chapters “Animations” and “Actions” inside this manual explain in detail how to 
link an Animation or an Action to objects.

Test your animations
You can test your project without exporting it to the eWON.

To do so, just launch the application simulator using the icon in the tool bar. 

The application simulator opens in your default browser.
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The upper section of this window shows the result of your project.

The lower section of this window allows you to simulate the tag values in order to test
the configured animations and actions.

You can simply change the value by entering a new one in the targeted field.

Digital Tag Analog Tag

You can also use a function to change the values of your tags automatically. For this
just choose one of the proposed functions and define a minimum/maximum value 
and the update period. Click “Play” icon to run the function(s) and “Stop” icon to 
stop them.

- Note -

To play the simulator on your PC, viewON uses the browser set as default. Verify that this 
browser version is compatible with viewON (See chapter “hardware and software 
requirements”) and if the browser is associated with the file extension “.html”.

Export the project to the eWON
To export the project to your eWON, use the «Export to the device» option under the
Project menu.
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- Caution -

Before exporting the new project, viewON clears the whole eWON directory “/usr/viewon”

- Note -

The IP address and user account of the eWON for the project export are configured in the 
properties window of the project. To open this window right click on the project in the «Project 
Editor» window and click on the Properties option.

- Note -

If you changed the connection settings or if you are exporting for the first time, you will need to 
first save the project.

4. Visualize the project on your eWON
To visualize the viewON project, inside the Web Browser simply use the following url: 

http://eWON_IP_Address/usr/viewon/index.html
(for example http://10.0.0.53/usr/viewon/index.html)

You will first be asked to log into your eWON.
Enter a valid user name and Password for the eWON connection.

After encoding the login you should see the viewON web pages in your Browser.
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Declare the viewON project as default home page
You can define your viewON project as the default homepage of your eWON. To 
visualize the viewON application inside your browser you just have to enter the 
eWON IP address.

To set the viewON application as default homepage on your eWON, open following
content on eWON's web interface:

Configuration → System Setup → General → Identification

In the «User define home page» list box, select the «viewON_synopsis» option and 
leave the second field empty.

- Note -

Once the viewON project is defined as default home page, to display the eWON configuration
pages use the following url: http://eWON_IP_Address/index.htm

Mobile adaptive view
Second important improvement starting viewON v4 is the new features targeting 
mobile devices.

ViewON provides a list of most used mobile devices/screens to the users. So that 
users can decide to size of the their views easier than before. 

Two new options were implemented: “Fit to screen” and “keep aspect ratio”
These options are important as they describe the behavior of viewON pages in the 
browser.

Page 16 / 51 viewON 4 | AUG 005



Chapter 4
Visualize the project on your eWON

Debugger has been updated as well to simulate different screen resolutions 
depending on the device (smartphone, device, computer...) used to check the 
simulation and the reaction of the viewON page to those screens.
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5. Visualization access rights
The access rights of the eWON can be used to restrict the value display or actions 
only to allowed users. 

Following eWON access rights are taken into account by the the viewON 
webpages:

Access rights Needed to

View I/O read a value out of the eWON (all tags)

Force Outputs write a value to the eWON

Acknowledge Alarms acknowledge alarms on the eWON

eWON File access [EBD] access Alarm History and Alarm Summary

Tag page Allowed
read a value out of the eWON (limit access to tags 
from Default and Selected page)

If one of the rights is not granted to the user, the webpage will display the following 

symbol on the object : 

These settings can be combined with the Users Rights Access feature of the viewON 
itself which is regrouped in 3 user groups:

• Viewers
They are the low-grade users and can not do any operations. They are read-
only users.

• Operators
They re more trusted users: they can write in the eWON, such as modifying tag 
values and acknowledging alarms.

• Administrators
They can do everything, including modifying the application configuration, 
although this outside the scope of viewON application.

The hierarchy implies that:

• Everything that is visible to Viewers is automatically visible to Operators and 
Admins.

• Everything that is visible to Operators is automatically visible to Admins.

The Users Right Management screen which allows users to modify existing eWON 
users access right through an FTP connection is accessible from: Project → Users 
Management.
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- Important-

Viewer, Operator and Admin are the new roles created for viewON. None of the existing 
eWON users will have these roles by default.  If users want to benefit from this feature they are 
first obliged to configure their users right from this screen.

To learn how grant access on components or views to users browsing the project, 
refer to the #6.10.Access User Rights|outline
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6. The viewON Editor Interface

The viewON editor is divided in several sections:

1. Menu bar

2. Tool bar

3. Project editor

4. Working area (Synoptics interface)

5. Graph. Properties and resources

6. Animations properties

7. Actions properties

8. Graphical component properties

9. Symbol tags editor

10.Acces User Rights

The following chapters will contain a brief explanation of every section listed above.
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Menu bar
Below, every menu will be listed with a short description of what can be done using 
the menu.

Project

Use this menu to create, open, rename or save your projects. 

This menu can also be used to:

• Import the Tags from your eWON (to allow animations 
and actions based on eWON tags)

• Export the project to your eWON 

Synoptics

Use this menu to create, open or save your synoptics.

This menu allows also to print a synoptic or to export the 
synoptic as bitmap or pdf file. 

Edit

Use this menu to edit the selected components on your 
synoptic.

The menu allows you to:

– copy/past objects

– copy/past dimensions (will only copy the dimensions of 
the selected object)

– group/ungroup objects

– enter/exit a selected group (allows to work on a separate 
object of the group without need to ungroup)

– lock/unlock objects (lock an object to avoid unintentional
move of the object)

– Choose the selection mode (object selection, zone 
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selection, etc)

- Note -

Most of these options are also accessible by a right mouse click on the object in the working 
area.

Drawing

Use this menu to add an object on the synoptic, as for 
example a rectangle, an ellipse, a path, an image or a text.

The «Insert/Delete a segment» and the «Path operation» 
options allow you to arrange (transform) the object as your 
pleases.

Using this menu you can also insert:

– special graphical components like a Combo Box or an 
Alarm History table

– insert a view  (to insert an existing view into the current 
view; useful for a custom menu bar for example)

– insert a symbol (a reusable object) 

With the «Options» sub-menu you can define the behavior 
of the working area, as for example Align on rulers, Forced Line mode, etc.

- Note -

Most of these options are also accessible from the tool bar of the viewON Editor

Transforms

Use this menu to determine the position of the selected object 
on the synoptic.

This menu allows, for example, to align the selected objects, to 
rotate the selected object, or to define which object has to be 
in front or in the back of the synoptic. 

Use also this menu to resize the canvas of your synoptic (custom 
size or fit to contents size)
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- Note -

Most of these options are also accessible by a right mouse click on the selected objects in the 
working area.

Display

Use this menu to select the frame (opened synoptic) you want to 
work on. Zoom options for the working area are also available.

This menu can also be used to display or hide the grid and the rulers
of the working area.

- Note -

The – and + buttons of the keyboard can be used to zoom in or out the working area.

Tools

This menu allows you to test your application without the 
need to transfer it first to your eWON. The application 
simulator will open in your default web browser in order to 
simulate your application.

Help

This menu allows you to register the viewON software and to display 
the information about software revision, etc.

Tool bar

Tool Action

The mouse pointer will allow you to select a separate object on the 
synoptic. (Selection)
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With the mouse you will be able to draw a rectangle in order to select the 
objects situated in between the rectangle. (Zone selection)

With the mouse you will be able to draw a rectangle to which the working
area will be zoomed towards. (Zoom on a zone)

Create rectangles and squares.

Create ellipses and circles.

Create a path.  To close the path realize a double click.

Insert an image.

Create a text element.

Insert a graphical component: Button, Check box, Toggle button, Combo 
box, List, Number Editor, Slider, Alarm history, Alarm summary, Menu bar, 
Trends

Insert a view

Insert a symbol

Activate/deactivate the «Repeated actions» mode. Allows, for example, 
to select by zone or to draw a shape several times, without being reset to 
the regular mode (simple selection mode).

Activate/deactivate the «Keep ratio» mode.

Activate/deactivate the «Align on rulers» mode.

Activate/deactivate the «Close path» mode. If this option is checked, 
then the last point of the drawn path will be automatically linked to the 
first point of the path. 

Activate the «Forced lines» mode. Activate this option if you want to draw 
a line or a square for example (not a curved line).

Test the animations and actions. Will open the default browser in order to 
simulate the application.

Project Editor
The Project Editor allows you to add, rename, import or delete a view in your 
project.
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Use the mouse right click in the Project editor to display the different context menus 
of the Project Editor.

The Project Editor allows you also:

• to define the properties of your project as for example the eWON IP address or 
the display refresh rate.

• to define which view will show up first when the project is opened on the 
eWON  (Main view).

View vs Synoptic

It is important to understand the difference between a View and a Synoptic.

A view is a synoptic which is linked to the project. But not every synoptic is linked to 
the project.

So you can, for example, open in the working area some synoptics which are not 
linked to the current project (not a view) in order to work on a symbol or just to get 
back some objects of an already existing synoptic. Even if these synoptics are 
displayed in the working area, they don't make part of the project. If you save the 
project, these synoptics will not be saved. 

To link an existing synoptic to your project, use the «Import view» option. The synoptic
will then be linked to your project. A copy of the synoptic will be saved into the 
workspace of your project.

Working area
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The working area will contain the different views of your project or the synoptics you 
opened.

Click on the different tabs to switch from one synoptic to the other.

To open a view, just click on the view in the Project editor.

To open a synoptic which is not linked to your project (not a view) use the 
«Synoptics/Open» menu.

- Note -

The keyboard arrow keys can be used to move a selected object. But for this, the Synoptic 
needs to have the focus. To set the focus on the synoptic just click with the mouse on the tab 
of the synoptic, once the synoptic displayed. 

The «*» displayed next to the view or synoptic name indicates that modifications have been 
operated on the synoptic but these modifications have not been saved yet.

To save the modified Views, just use the «Project/Save project» menu.

To save a synoptic that is not linked to the project (not a view) use the 
«Synoptics/Save» menu or use the close button on the synoptic tab:
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Graph. Properties and Resources
The Graph. properties section allows to set the properties of the selected graphical 
object. 

For example, if you select a rectangle on the synoptic, the Graph. properties section
will allow you to define following:

• Fill tab:  to define the fill color and opacity
• Line tab: to define the line color, opacity, 

width and dash options

• Geom. tab: to define the position and 
dimensions of the selected object and to 
define the corner radius

• Id. tab: to define the ID number of the object 
(not of any use in this viewON version)

• Display tab: to define the opacity of the entire
object and if the object should be visible or 
not 

The Graph. resources section allows you to define a linear or radial color gradient. 
This color gradient (graph. resource) can then be used to define the fill color of a 
rectangle  for example.

• Linear gradient tab: to define a linear 
gradient color

• Radial gradient tab: to define a radial 
gradient color

The icons on the right bottom of the Graph 
resources window allow you to add, duplicate 
or delete a gradient.
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The Gradient properties window can be opened just by a
double-click on the gradient itself or using the Properties 
icon on the bottom of the window.

Colors section: 
Use the «Add a new color item» button to add a 

supplementary color for the gradient 
definition.

Click on this slider to move the gradient and to define
the color of the gradient  
Vector section: 
Use these fields to define the gradient orientation, ex 
from bottom to top, etc.
Id section: 
Set the name of the gradient

To apply a linear gradient to the selected object (a rectangle for example) use the 
«Resource» field instead of the color field in the Paint section of the Graph. 
Properties windows:

The gradient color option allows you to give an 3D aspect to your objects as shown 
on the following two objects:
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Animations properties

Use the «new» button on the bottom of the animations window to add an animation
to the selected object.

The context menu will allow you to select the animation you want to apply to your 
object. 

For example, the following picture shows the Animation properties window for a 
«color on state» animation:
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The different possible animations are listed in the following table:

Animation  Type Description

Color State Color animation using a state variable (Boolean tag,
alarm status, alarm type)

Color Measure Color animation using analog tag intervals

Color Bar graph Bar graph animation using analog tag value

Opacity State Opacity animation using a state variable (Boolean 
tag, alarm status, alarm type)

Opacity Interval Opacity animation using analog tag intervals

Opacity Measure Opacity animation using analog tag value

Visibility State Visibility animation using a state variable (Boolean 
tag, alarm status, alarm type)

Visibility Interval Visibility animation using analog tag intervals

Movement Translation Object translation (xy to xy) using analog tag value 

Movement Rotation Object rotation using analog tag value

Movement Scale Object resizing using analog tag value

Text Simple Text animation using eWON Script

Text State Text animation using a state variable (Boolean tag, 
alarm status, alarm type)

Text Measure Text animation using analog tag value. Will display 
the analog tag value.

Text Current User Will display the current logged user
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Actions properties

Use the «new» button to add an action to the selected object.

The context menu will allow you to select the actions you want to apply to your 
object. 

For example the following picture shows the Actions properties window for a «Send 
Command» action:

The different possible actions are listed in the following table:
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Action  Type Description

Send Command Send 0 or 1 to a boolean Tag, or execute an eWON 
Script

Send Command by 
reference

Send the boolean value of one eWON Tag into 
another eWON Tag.

Send Measure Send a value into an analog eWON Tag

Load View Manage views: open a new view, back to previous 
view, quit view

Load URL Display another web page by indicating the URL 

Graphical component properties
There are some special graphical components at your disposal in the viewON Editor 
(Button, List, Alarm history, etc.).

For these graphical components the «Graph. Properties» window only allows the 
configuration of the geometrical location and the display options (opacity, visibility, 
etc).

To define the other properties that are linked to the selected graphical component, 
the «Graphical component properties» window displayed in the bottom of the Editor
has to be used.

For example, for the graphical component «Button» following window will be 
displayed:

Here you can define the text contents and format of the button .

Or for example, the graphical component  «Alarm summary» can be configured 
using the following Graphical component properties window.
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Symbol tags editor
You can insert symbols into your view. 

A symbol is an object with predefined graphical components and animations. A 
symbol can be, for example, a tank or a motor.

Even if the symbol is composed of several different graphical components and 
animations it will be represented in your view as one unique object.

To configure the animations and actions which make part of the symbol, the 
«symbol tags editor» window displayed in the bottom of the viewON Editor has to be
used.

If the selected symbol contains animations, then you will find here a list of all the 
different «Symbol Tags» used for the different animations.

Every Tag must be linked to an eWON Tag to make the animation work.

The «<None>» indicates that the symbol tag has not been linked to an eWON Tag 
yet.
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To link an eWON Tag select the symbol Tag in the list and click on the browse button 
on the right bottom. 

The «Tag view database» window will show up:

Select the eWON Tag or the Script to link to the symbol Tag and click on the OK 
button. 

Access User Rights
This feature is highly connected to the firmware of the eWON.

All users defined in the eWON can be linked to one of the 4 user groups: None, 
Viewers, Operators or Administrators.

These user groups will then be configured to be able to see some views or 
components of the project.

As viewON retrieves those users directly from the eWON, the eWON needs to be 
connected. Once the links between eWOn users & viewON user groups are 
established, the viewON will push back the new configuration to the eWON.
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In the “Access” tab under the canvas, users may decide which user roles can 
access to specific components or to the whole view from this tab.

If you want to grant access on:

• a component, this one needs to be first selected in your project

• a view, this one needs to be highlighted, without any component selected

- Tips -

The line above the 3 options indicates what will be visible to whom. Depending on what's 
selected you will have

This view is visible by
This component is visible by

Enabling the User security can be done either through the Project > Project 
Properties menu or via the Access panel whereas disabling it can only be done via 
the first method.

- Note -

 If users disable back the user security option all components and pages will be accessible to 
every user like before.
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7. Animations
To add an animation on an object, select the object in the working area and click 
the  button «new» located at the bottom of the animations window.

The context menu will allow you to select the animation you want to apply to your 
object. 

The following picture shows the Animation properties window for a «color on state» 
animation:

If needed, configure the Line and Fill check boxes and the associated colors for an 
invalid state. 
viewON applies the invalid settings (if checked) to the object when the value 
cannot be read from the eWON (or when the value is out of range in case a 
min/max range must be defined for the object)

The Line and Fill options by default are not of any use in the actual viewON version.

Click on the Tag selection button in the tag field to show up the Tags database.
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This window lists the different tags available on your eWON 
which can be used for the selected animation.
For example, because we choose a «State» animation, only 
boolean tags are listed here.
You can now select the tag to use for the animation. 
You can also use the Script tab to enter an eWON script. 
The result of this script will then be used for the animation.

Animation using a Tag
You can animate your object just by using a Tag value (Boolean or analog)

If you select for example the Tag «O2» in the tags view database window, then the 
animation properties window will look like this:

In the «Tag values» section you must define the colors for the different states of the 
boolean Tag.

Animation using Tag Attributes
Using the «Attribute filter» option in the «Tag view database» window, it is also 
possible to configure an animation using the alarm states or alarm types of a Tag.
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You can for example animate your objects with a different color for every alarm 
state (None, Alarm, Ack, RTN).

Animation using eWON Script
Instead of using a tag value or a tag status for the animation, you can also animate 
your object using an eWON Script. 

- Note -

Exchanges between the viewON application and the eWON are made by the BASIC variable 
«viewon!». 

The viewon! variable is of type string!

If, for example, you want to display the date an time on your viewON synoptic, then 
choose a text object and apply a simple text animation on this object. 
In the «Tag view database» open the Script tab and declare following script:
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At every refresh interval, the text object will then be updated with the date and time
of the eWON.
Other possible scripts could for example be «viewon! = A$» or «viewon! = STR$ 
MyTag@», etc.

- Note -

The viewON BASIC scripts will be placed into the «Basic action» stack of the eWON. Because 
the script is used on an animation, the script will be placed into the eWON stack at every 
update interval. So develop the viewON Scripts according to this.

Multiple animation
It is also possible to combine multiple animations on the same object using the 
«New» button in the Animations properties window.
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8. Actions
To add an action to an object, select the object in the working area and click the  
button «new» at the bottom of the Actions window.

The context menu will allow you to select the actions you want to apply on your 
object. 

The following picture shows the Actions properties window for a «Send Command» 
action:

Click on the Tag selection button in the «Tag to write» field to show up the Tags  
database.

This window will list the different tags available on your eWON and
which can be used for the selected action.
For example, because we choose a «Send Command» action, 
only boolean tags are listed here. You can now select the tag to 
use for the animation. 
You can also use the Script tab to enter an eWON script. The  
script will then be executed on the eWON every time the action is
performed.
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- Note -

You can also combine multiple actions on the same object using the «New» button in the 
Actions properties window.

Actions using a Tag
By selecting a Tag, you can force the value of this Tag to 0 or 1.

If you select for example the Tag «bit1», the action properties window will look like 
this:

In the «Value» field enter the value that will be applied on the selected Tag, every 
time the action is executed.

Actions using eWON Script
Instead of setting directly the value of a tag, you can also run an eWON script every 
time the action is performed.

- Note -

Exchanges between the viewON application and the eWON are made by the BASIC variable 
«viewon!». 

The viewon! variable is of type string!

For example place the following «Send command» action on a button:
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This script will set the eWON tag DO1 to 1 every time the action is performed, so 
every time the button is used.

In the action script you can also use the viewon! variable. Before the execution of 
the script on the eWON, the viewon! variable will be replaced by the value set by 
the associated action. For example

In the example shown here above, the DO1 Tag on the eWON will be set to 0 every 
time the action is performed.
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Alternative Layout
This action can be seen as a redirection of a view depending on the screen 
resolution. Users may want to have a main view and an alternative one (of the same
view) dedicated for mobile devices. 

Let's say the project has following two views:

• main

• main_mobile

We may want to redirect main.shtm to main_mobile.shtm when the first one is 
displayed on a mobile device: we can only do it on the client side with javascript.

- Note -

Once you add an alternative layout action to a page, viewON compilation process will create
two web pages

Extended to the above example, it would render:

• Main Window.shtm: This page is an empty page only with the redirect config. It
redirects the users to main.shtm or main_mobile.shtm depending on the 
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devices screen resolution you are accessing the web page from.

• Main Window_.shtm: This page has the real content of the main view.

• Test.shtm: This page is being loaded instead of Main Window_shtm if you are 
on an iPhone 6 (or similar screen resolution).

For more information on Alternative Layout, refer to AUG-006: viewON - Objects, 
Animations and Actions
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9. Client side Scripting
Client side scripting is a feature which enables users to add their own JS code to a 
viewON view. 

Before v4, user needed to send the script to the eWON which would send back the 
result of the script. This didn't maky ane sense for script targeting translation, rotation,
... animations.

Starting v4, all scripts are dealt locally, directly inside the project.

viewON tags
This is a term which is very important: viewON tags means client side tags.

If we speak technically they are JavaScript objects. 

viewON tags exist only on the client side and their value is lost every time the page is
refreshed.

- Important -

eWON tags and viewON tags ARE NOT THE SAME.
viewON tags are defined for each view of the project separately by the users, eWON tags are 
imported from eWON.

Users may access to viewON tags management by right clicking to their view on the
project tree. 

When a user clicks on a viewON tag item, he will be landing on the following screen:
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The viewON Tags Management frame lists the viewON tags of the selected view. 
User will add/remove/update the viewON tags of this view. 

There are two types of viewON tags: boolean and analog.
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These viewOn tags can be used afterwards in animations/actions and JavaScript 
sections like eWON tags. Because of that, tag selection window has been modified 
(left is previous, right is after):

viewON Script sections and Execute viewON Script actions
viewON script section are actually JavaScript sections written by the users. They are 
also called viewON Scripts in order to distinguish them from the BASIC Scripting. 

User can change the value of viewON tags by sendCommand, sendMeasure and 
sendCommandByRef actions like eWON tags. 

Users may also change the values of these tags by using the viewON scripts.

User may type viewOn scripts in two places:

1. Global JavaScript Section
JavaScript code written in this section is directly attached to the view (not to 
an element) like all other global actions. And this section is executed 
periodically in the desired interval.

- Note -
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Minimum limit of execution interval is 100 milliseconds. If user types a value less than 100, 
section is executed only once. 

2. Execute viewON Script Action
This action can be added to buttons and SVG elements. JavaScript code 
written in this section is executed only when the user triggers the action.

Some special method calls need to be used to read/write eWON/viewON tags:

• getEwonTagVal('tagName')
reads eWON tag value from the page cache

• getViewOnTagVal('tagName')
reads viewON tag value

• setEwonTagVal('tagName', value)
writes ewon tag value, send an AJAX call

• setViewOnTagVal('tagName', value)
writes viewON tag value

You may find more detail about these method in the application (by hitting CTRL + 
Space while typing the function name).

These write changes are not directly applied. All change requests are sent to the 
server (committed) at the end of the script execution.

If users want to send these changes directly to the server they should call  a function
after each set tag method calls

commitEwonTagChanges() 

- Note -

Users may also access to jQuery v2.1.0 and  jQuery UI – v1.10.4 API from this code sections.

Debug & Help
To debug their JS code, users can use the debugging tools of the browsers like 
Chrome and Firefox to add breakpoints etc..
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Starting v4, viewON has a special JavaScript code area which highlights and 
validates the JavaScript syntax. If users type “Ctrl + Space” this code area will 
display available functions list.
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Revision

Revision History

Revision Level Date Description

1.0 10/06/2016 Second main version of viewON AUG
Client Side Scripting, Access Rights, 
Alternative Layout

1.1 08/11/2017 ADDED: IE10 restrictions

Document build number: 105

Note concerning the warranty and the rights of ownership:

The information contained in this document is subject to modification without notice. Check 
http://wiki.ewon.biz for the latest documents releases.

The vendor and the authors of this manual are not liable for the errors it may contain, nor for their 
eventual consequences.

No liability or warranty, explicit or implicit, is made concerning the quality, the accuracy and the 
correctness of the information contained in this document. In no case the manufacturer's 
responsibility could be called for direct, indirect, accidental or other damage occurring from any 
defect of the product of errors coming from this document.

The product names are mentioned in this manual for information purposes only. The trade marks and 
the product names or marks contained in this document are the property of their respective owners.

This document contains materials protected by the International Copyright Laws. All reproduction 
rights are reserved. No part of this handbook can be reproduced, transmitted or copied in any way 
without written consent from the manufacturer and/or the authors of this handbook.

eWON sa, Member of ACT'L Group
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Endnotes
i Microsoft, Internet Explorer and Windows are either registered trademarks or trademarks of Microsoft 

Corporation 
ii Firefox is a trademark of the Mozilla Foundation
iii Chrome is a trademark of the Google Foundation
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